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2 Important notice

NXP provides the enclosed product(s) under the following conditions:

This evaluation kit is intended for use of ENGINEERING DEVELOPMENT OR
EVALUATION PURPOSES ONLY. It is provided as a sample IC pre-soldered to a
printed circuit board to make it easier to access inputs, outputs, and supply terminals.
This evaluation board may be used with any development system or other source of
I/O signals by simply connecting it to the host MCU or computer board via off-the-
shelf cables. This evaluation board is not a Reference Design and is not intended to
represent a final design recommendation for any particular application. Final device in
an application will be heavily dependent on proper printed circuit board layout and heat
sinking design as well as attention to supply filtering, transient suppression, and I/O
signal quality.

The goods provided may not be complete in terms of required design, marketing, and
or manufacturing related protective considerations, including product safety measures
typically found in the end product incorporating the goods. Due to the open construction
of the product, it is the user’s responsibility to take any and all appropriate precautions
with regard to electrostatic discharge. In order to minimize risks associated with the
customers applications, adequate design and operating safeguards must be provided
by the customer to minimize inherent or procedural hazards. For any safety concerns,
contact NXP sales and technical support services.

Should this evaluation kit not meet the specifications indicated in the kit, it may be
returned within 30 days from the date of delivery and will be replaced by a new kit.

NXP reserves the right to make changes without further notice to any products herein.
NXP makes no warranty, representation or guarantee regarding the suitability of its
products for any particular purpose, nor does NXP assume any liability arising out of the
application or use of any product or circuit, and specifically disclaims any and all liability,
including without limitation consequential or incidental damages. “Typical” parameters
can and do vary in different applications and actual performance may vary over time.
All operating parameters, including “Typical”, must be validated for each customer
application by customer’s technical experts.

NXP does not convey any license under its patent rights nor the rights of others. NXP
products are not designed, intended, or authorized for use as components in systems
intended for surgical implant into the body, or other applications intended to support or
sustain life, or for any other application in which the failure of the NXP product could
create a situation where personal injury or death may occur.

Should the Buyer purchase or use NXP products for any such unintended or
unauthorized application, the Buyer shall indemnify and hold NXP and its officers,
employees, subsidiaries, affiliates, and distributors harmless against all claims, costs,
damages, and expenses, and reasonable attorney fees arising out of, directly or
indirectly, any claim of personal injury or death associated with such unintended or
unauthorized use, even if such claim alleges NXP was negligent regarding the design
or manufacture of the part. NXP and the NXP logo are trademarks of NXP B.V. All other
product or service names are the property of their respective owners. © 2018 NXP B.V.
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3 Overview

The FRDM-32XSG-EVB is an evaluation platform for developing designs based on
NXP’s MC17XSG500 high-side switch power IC. The board allows external components
such as fans, lights, pumps and DC motors to be connected to the MC17XSG500’s high-
side switches.

The FRDM-32XSG-EVB requires a companion board to manage communications
between the evaluation board and a host PC. There are two options for providing that
functionality. This user guide will only focus on the first option that are Arduino boards.

Arduino boards

Arduino boards (sold separately) enable users with a minimal knowledge of electronics
to create simple systems that control external components. The boards act as a
communication link between a host PC and an attached shield board (in this case,
the FRDM-32XSG-EVB.) User’s download the Arduino Software IDE to develop code
that exercises the functionality of the attached shield board. NXP makes available a
compatible eSwitch library of FRDM-32XSG-EVB-specific functions that are imported into
the Arduino Software. The eSwitch library functions have all the capabilities needed to
access and control the MC17XSG500.

NXP Freedom boards

The FRDM-32XSG-EVB is also compatible with a wide range of Kinetis Freedom boards
from NXP, thanks to the Arduino connectors. In this configuration, the Freedom board
serves primarily as the SPI communication link between the evaluation board and
the host PC. The software interface is through NXP’s CodeWarrior IDE (Integrated
Design Environment) or Kinetis Design Studio and the CodeWarrior Gen4XtremeSwitch
component. A CodeWarrior and KDS example project, available as a .zip file on NXP’s
website, incorporates the Gen4XtremeSwitch component and demonstrates a typical
implementation using the FRDM-32XSG-EVB associated with FRDM-KL25Z. Designers
can connect components to the evaluation board and modify the code in the example to
suit their development needs.

For more details, please consult this tool summary page:

www.nxp.com/products/:GEN4-EXTREMESWITCH-PEXPERT

4 Getting started

The NXP analog product development boards provide an easy-to-use platform for
evaluating NXP products. The boards support a range of analog, mixed-signal and
power solutions. They incorporate monolithic integrated circuits and system-in-package
devices that use proven high-volume technology. NXP products offer longer battery life, a
smaller form factor, reduced component counts, lower cost and improved performance in
powering state-of-the-art systems.

The tool summary page for FRDM-32XSG-EVB is located at http://www.nxp.com/
FRDM-32XSG-EVB. The overview tab provides an overview of the device, product
features, a description of the kit contents, a list of (and links to) supported devices, list of
(and links to) any related products and a Get Started section.

The Get Started section provides links to everything needed to start using the device
and contains the most relevant, current information applicable to the FRDM-32XSG-EVB.

• Go to http://www.nxp.com/FRDM-32XSG-EVB.

www.nxp.com/products/:GEN4-EXTREMESWITCH-PEXPERT
http://www.nxp.com/FRDM-32XSG-EVB
http://www.nxp.com/FRDM-32XSG-EVB
http://www.nxp.com/FRDM-32XSG-EVB
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• On the Overview tab, locate the Jump To navigation feature on the left side of the
window.

• Select either the Get Started link or scroll in the main window of the Overview tab until
the Get Started section is visible.

• Review each entry in the Get Started section.
• Download an entry by clicking on the title.
• After reviewing the Overview tab, visit the other product related tabs for additional

information:
– Documentation: download current documentation
– Software & Tools: download current hardware and software tools
– Buy/Parametrics: purchase the product and view the product parametrics

After downloading files, review each file, including the user guide which includes setup
instructions. If applicable, the bill of materials (BOM) and supporting schematics are also
available for download in the Get Started section of the Overview tab.

4.1 Kit contents/packing list
The FRDM-32XSG-EVB kit contents include:

• Assembled and tested evaluation board in an anti-static bag
• Power connectors
• Quick start guide

4.2 Required equipment
This kit requires the following items:

• 3/16" blade screwdriver for connecting the loads
• DC Power supply: 7.0 V to 30 V with up to 20 A current handling capability, depending

on motor requirements
• USB Standard A (male) to B (male) cable
• Typical loads (brushed DC motor, power resistors or inductive load with up to 5.0 A and

28 V operation)
• Development board for SPI communication

– Arduino Uno (All revisions)
– Arduino Due
– Arduino Leonardo

4.3 System requirements
The kit requires the following to function properly with the software:

• USB enabled computer running Windows XP or newer
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5 Getting to know the hardware

5.1 Board overview
The FRDM-32XSG-EVB evaluation kit exercises all the functions of the MC17XSG500
high-side switch. The onboard device provides five power outputs.

The evaluation board can be used in conjunction with a FRDM-KL25Z board or an
Arduino development board connected to a PC’s USB port.

These development boards support SPI communication with the FRDM-32XSG-EVB
board and enable configuration, control and status monitoring of the MC17XSG500.

5.2 Board features
The board features are as follows:

The FRDM-32XSG-EVB provides a platform for evaluating the functionality of NXP’s
MC17XSG500 high-side switch IC. The board features the following:

• Five configurable power outputs with current, voltage and overtemperature protection
• Power connectors to control various types of external loads
• 5.0 V voltage regulator
• LEDs to indicate supply and output status
• Low Equivalent Series Resistance (ESR) capacitor to reduce ripple in the power supply
• SPI Chip Select switch capable of addressing up to four stacked FRDM-32XSG-EVB

boards, see Table 8
• Freewheeling diodes on all power channels

5.3 Block diagram
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Figure 2. Block diagram
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5.4 Device features

Table 1. Device features
Device Description Features

MC17XSG500 The MC17XSG500 is a penta 17 mΩ smart
high-side switch power IC, enhanced with
SPI configuration, protection and diagnostic
capabilities

• Normal operating range: 7.0 V to 30 V
• Extended operating range: 6.0 V to 32 V
• 5.5 A steady-state current per channel
• Analog feedback pin providing supply voltage,

temperature monitoring and channel current
sensing

• Advanced current sense mode for LED usage
• 16-bit 5.0 MHz SPI communication for

channel control, including PWM duty cycles,
OpenLoad detection, thermal shutdown and
fault reporting

• Overload, overtemperature, overvoltage and
undervoltage protections

• –16 V reverse polarity and ground disconnect
protections

5.5 Application diagram

Figure 3. Application diagram
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5.6 Internal block diagram

Figure 4. Internal block diagram
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5.7 Board description

aaa-026119

Output
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MC17XSG500Push button

OUT6
Connector

Supply
connectors

Chip Select switch Direct inputs switch

Power diodes

Supply connector 5.0 V

Figure 5. Board description

Table 2. Board description
Name Description

Output connector Power connection for outputs HS1 through HS5 and ground

MC17XSG500 Penta high-side smart switch

Push button LIMP mode button

OUT6 connector External smart power switch driver

Supply connectors Jack and 2-pin power connectors

Chip Select switch Switch used to select CS signal when stacking boards

Direct inputs switch Switch used to set the state of an input in LIMP mode

Power diodes Freewheeling diodes for inductive loads
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Name Description

Supply connector Power connection for VPWR and ground

5.0 V 5.0 V supply for VDD

5.8 Input signal definition
The following input signals control the outputs or functions inside the circuit.

Table 3. Input signal definitions
Input name Description

D0, D1, D3, D4 Logic input to control the output state of HS1..4

MOSI Master Out Slave In signal for the SPI

CSB0 through CSB3 Chip select signals for different boards

SCLK Clock for the SPI

RSTB Reset of devices. Active Low

CLOCK External clock for PWM

5.9 Output signal definitions
The FRDM-32XSG-EVB uses the following output signals to reflect the fault and device
status as well as to drive a load. The board provides an analog output for real-time load
current monitoring.

Table 4. Output signal definitions
Output name Description

HS1 through HS4 Power outputs of both devices

MISO Master In Slave Out signal for the SPI

CSNS Analog monitoring of output current and ICs temperature

SYNC Trigger signal for measurements on CSNS pin
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5.10 LED display

Figure 6. LED locations

Table 5. LED locations
LED ID Description

D4 LED Green. Indicates power to OUT_1

D7 LED Green. Indicates 5.0 V supply

D9 LED Green. Indicates power to OUT_2

D10 LED Green. Indicates power to OUT_3

D11 LED Green. Indicates power to OUT_4

D12 LED Green. Indicates power to OUT_5
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5.11 Test points

Figure 7. Test point locations

Table 6. Test point definitions
Label Description

TP1 Ground test point

5.12 Connectors

Figure 8. Connectors
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Table 7. Connector definitions
Label Description Number Name Function

1 VBAT DC power
J1 Two-pin power supply

2 AGND DC ground

J2 OUT6 OUT_6 External smart power switch
driver

1 OUT_2 Power connection for HS2

2 OUT_4 Power connection for HS4

3 OUT_5 Power connection for HS5

4 OUT_3 Power connection for HS3

5 OUT_1 Power connection for HS1

J7 HSx Power/Ground

6 AGND HSx Ground

J8 Jack power supply VBAT/AGND DC power jack

5.13 Switches

Figure 9. Switches

Table 8. Switch descriptions
Label Name Position Function

1 Selects 5.0 V supply to IN1

2 Selects 5.0 V supply to IN2

3 Selects 5.0 V supply to IN3

SW1 Direct input switches

4 Selects 5.0 V supply to IN4
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Label Name Position Function

1 Selects connection from J1 pin8 to
SPI0_CSB_FRDM

2 Selects connection from J1 pin6 to
SPI0_CSB_FRDM

3 Selects connection from J1 pin3 to
SPI0_CSB_FRDM

SW2[1] Chip select switch

4 Selects connection from J2 pin3 to
SPI0_CSB_FRDM

SW3 LIMP mode button — Selects LIMP mode

[1] SW2 acts as an address switch that allows stacking of up to four boards.

6 Operating with Arduino Uno and the Arduino software

The FRDM-32XSG-EVB supports the following Arduino boards:

• The Arduino Uno R3 is based on the Atmel ATmega328 8-bit microcontroller with
32 Kb of flash memory. The board contains fourteen GPIO pins (six of which are PWM
enabled) and six analog inputs.

• The Arduino Due is based on the Atmel SAM3X8E ARM Cortex-M3 CPU, a 32-bit ARM
core microcontroller with 256 Kb of flash memory. The board contains 54 GPIO pins
(13 of which are PWM enabled) and 12 analog inputs. The Arduino Due also offers
an USB OTG capable connection, two DAC (digital to analog converters), two TWI
connectors, a SPI header and a JTAG header.

• The Arduino Leonardo is based on the Atmel ATmega32U4 8-bit microcontroller with
32 Kb of flash memory. It has 20 GPIO pins (seven of which are PWM enabled) and 12
analog inputs. The board also offers a micro USB connection and an ICSP header.

This section describes operating with the Arduino Uno R3. The procedures are similar for
the Arduino Due and the Arduino Leonardo.

6.1 Connecting the FRDM-32XSG-EVB to an Arduino board
The Arduino board connects to a PC through a USB port, which allows the user to
program it using the Arduino Software.

The Arduino board controls the power outputs and sets the features of the
FRDM-32XSG-EVB’s MC17XSG500 smart high-side switch power IC. The Arduino
board also monitors the SPI registers, thereby facilitating the use of safety and advanced
diagnostic functions.

The FRDM-32XSG-EVB connects to the Arduino Uno using the four single-row Arduino
connectors on the bottom of the board (see Figure 10).
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Figure 10. Connecting the FRDM-32XSG-EVB to an Arduino board

Table 9 shows the connections between the FRDM-32XSG-EVB and an Arduino board.

Table 9. FRDM-32XSG-EVB to Arduino board connections

Header Pin Arduino board
hardware name

Freedom board
hardware name Description

0 D0 IN1 IN1 signal for HS1

1 D1 IN2 IN2 signal for HS2

2 D2 CSB1 SPI chip Select 1

3 D3 IN3 IN3 signal for HS3

4 D4 IN4 IN4 signal for HS4

5 D5 CSB2 SPI Chip Select 2

6 D6 CLK Output PWM clock reference

7 D7 CSB3 SPI Chip Select 3

8 D8 CSNS SYNC CSNS trigger signal

9 D9 RSTB MC17XSG500 reset signal

10 D10 CSB0 SPI Chip Select 0

11 D11 MOSI SPI Data OUT

12 D12 MISO SPI Data IN

13 D13 SCLK SPI clock

Digital

14 GND AGND Ground

1 A0 CSNS No connection

2 A1 N/C No connection

3 A2 N/C No connection

4 A3 N/C No connection

5 A4 N/C No connection

Analog

6 A5 N/C No connection
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Header Pin Arduino board
hardware name

Freedom board
hardware name Description

1 Vin N/C No connection

2 GND AGND Ground

3 GND AGND Ground

4 5V N/C No connection

5 3.3V P3V3 3.3 V supply

6 RESET N/C No connection

Power

7 IOREF P3V3 3.3 V supply

6.2 Configuring the hardware
The FRDM-32XSG-EVB consists of five high-side power channels driven through a SPI
interface. The board can be configured for use with an Arduino development board or a
FRDM-KL25Z board and the Gen4XtremeSwitch Processor Expert component.

Caution: When using the FRDM-32XSG-EVB, make sure that the maximum supply
voltage (VPWR) stays within the 5.0 V to 32 V range. Operating outside this range may
damage the board.

The procedure for configuring the FRDM-32XSG-EVB for use with an Arduino board is as
follows:

1. Connect the FRDM-32XSG-EVB to the Arduino Uno using the Arduino connectors on
each board.

2. Connect the USB cable (not supplied with the kit) between the PC and the Arduino
Uno board.

3. With the power switched off, connect the power supply to the jack connector (J8) or
attach the DC power supply to the VBAT and GND screw connector terminal (J1) on
the evaluation board.

4. Screw the wires of each load to the 6-pin power connector (J7) provided. Ground is on
pin 6.

5. Switch the power supply on. The green LEDs adjacent to connector J7 will light when
a channel is set to ON, either by the SW1 switch or with SPI commands.

Figure 11 illustrates the hardware configuration using an Arduino board.
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Figure 11. FRDM-32XSG-EVB configured for use with an Arduino board

For more details on setting up the Arduino board, see www.arduino.cc/en/Guide/
HomePage.

6.3 Setting up the software
Prior to any evaluation on the FRDM-32XSG-EVB board, the following Arduino software
must be installed:

• The Arduino software (IDE)
 www.arduino.cc/en/Main/Software

• The FRDM-32XSG-EVB eSwitch library
 https://source.codeaurora.org/external/32xsg_ino.
The eSwitch library contains drivers that make device operations easier to implement.
To download the library, open a 'Git' invite command on your computer (installation
link: https://git-scm.com/book/en/v2/Getting-Started-Installing-Git) and clone the
library with the following command: git clone https://source.codeaurora.org/
external/32xsg_ino/eswitch. The library folder is now downloaded in the repository
selected with Git.

For more details on Arduino installation and its configuration and usage, review the
Arduino tutorials at www.arduino.cc/en/Tutorial/HomePage.

www.arduino.cc/en/Guide/HomePage
www.arduino.cc/en/Guide/HomePage
www.arduino.cc/en/Main/Software
https://source.codeaurora.org/external/32xsg_ino
https://git-scm.com/book/en/v2/Getting-Started-Installing-Git
www.arduino.cc/en/Tutorial/HomePage
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6.4 Importing the eSwitch library into the Arduino software
Prior to using the Arduino Software (IDE) for development, the FRDM-32XSG-EVB
eSwitch library downloaded in Section 6.3 "Setting up the software" must be imported
into the software. The procedure is as follows:

1. Open the Arduino software.
2. From the menu bar, click Sketch->Include Library. When the Select a zip file...

window opens, browse for the location of the eSwitch library that was downloaded in
Section 6.3 "Setting up the software".

3. Select the library, and then click Open.
 

aaa-026203

 
4. Verify that the library has been imported. Click Sketch->Include Library and then

confirm that FRDM-32XSG-EVB-Arduino-master appears as a menu item.
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aaa-026217

 

6.5 Creating a new project
To create a new FRDM-32XSG-EVB project in the Arduino software, do the following:

1. Open the Arduino software (IDE).
2. From the File menu, click New. A new Sketch window opens.
3. Within the open and close brackets of the setup() function, enter XS-Init(); to invoke

a function that initializes the FRDM-32XSG-EVB board and enables all of the library
functions.
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aaa-026219

 

XS_Init initializes the SPI bus, allowing the Arduino Uno board to communicate with
the FRDM-32XSG-EVB board. It also sets the current sense pin, the PWM clock and
the RSTB pin. At runtime, a function within XS_Init executes every 10 ms to toggle the
Watchdog value, thereby preventing the MC17XSG500 from entering Fail mode.

6.6 Function descriptions
The eSwitch library contains eight functions that provide a means of controlling the
FRDM-32XSG-EVB board.

6.6.1 WriteRegister
Writes 16-bits of data to the specified SPI register.

WriteRegister(reg_addr, data)
   reg_addr  byte                address of the SPI register
   data      unsigned integer    data to be sent
Return  void

6.6.2 ReadRegister
Returns the 16-bit contents of the SPI output register. (For SPI output register bit
descriptions, see the MC32XSG datasheet here: www.nxp.com/files/analog/doc/
data_sheet/MC32XSG.pdf.

ReadRegister(reg_addr)
   reg_addr  byte           address of the SPI output register
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Return  unsigned integer    Contents of the SPI output register

6.6.3 SetOutputState
Toggles the ON/OFF state of the specified high-side switch power output (HS1 through
HS5).

SetOutputState(output, state)

   output  byte     The number id of the high-side switch to be
                    toggled (1=HS1, 2=HS2...5=HS5)
   state   boolean  The specified ON/OFF state (0=OFF, 1=ON)
Return  void

6.6.4 SetPWMDuty
Changes the PWM duty cycle for the specified high-side switch power output (HS1
through HS5).

SetPWMDuty(output, state)
   output  byte    The number id of the high-side switch to be
                   toggled (1=HS1, 2=HS2...5=HS5)
   value   byte    The duty cycle specified as a number between
 0 to 255
Return  void

6.6.5 SetMonitoring
Changes the type of feedback provided by the MC17XSG500 CSNS pin. (The CSNS
pin provides selectable analog feedback on output current per high-side switch, power
supply voltage or temperature.

SetMonitoring(mux_value)
   mux_value  byte    A number indicating the type of feedback
                      CSNS outputs. Allowable values are:
                      • 0 = Off
                      • 1 = Output1 (HS1) current
                      • 2 = Output2 (HS2) current
                      • 3 = Output3 (HS3) current
                      • 4 = Output4 (HS4) current
                      • 5 = Output5 (HS5) current
                      • 6 = VPWR
                      • 8 = Temperature
Return  void

6.6.6 GetOutputCurrent
Reads the MC17XSG500’s CSNS pin and returns the current flowing through the
specified high-side switch power output (HS1 through HS5). The desired high-side switch
must be selected by the SetMonitoring function prior to invoking GetOutputCurrent.

GetOutputCurrent( )
   void        No input parameters
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Return  float  The output current in amps on the
               selected high-side switch

6.6.7 GetVPWR
Reads the MC17XSG500’s CSNS pin and returns the power supply voltage in
volts. VPWR output must be selected by the SetMonitoring function prior to invoking
GetOutputCurrent.

GetOutputCurrent( )
   void       No input parameters
Return float  The power supply voltage in volts

6.6.8 GetTemperature
Reads the MC17XSG500’s CSNS pin and returns the temperature of the device in
degrees Centigrade. Temperature output must be selected by the SetMonitoring function
prior to invoking GetOutputCurrent.

GetOutputCurrent( )
   void  No input parameters
Return float  The temperature in degrees Centigrade
                    of the MC17XSG500 on the FRDM32XSGEVB

6.7 Code example
The following section of code illustrates a typical implementation of the FRDM-32XSG-
EVB being used with an Arduino Uno board. The code sets the MC17XSG500 CSNS
pin to output power supply voltage and later reads the voltage into a variable. It turns ON
the high-side switch output 2 (HS2) and sets the PWM duty cycle on the high-side switch
output 3 (HS3) to 50 %. Finally, diagnostic information in the MC17XSG500 Quick Status
register is read into a variable.

#include <Arduino.h>
#include <eSwitch.h>

float voltage;
float temperature;
float current;
unsigned int diagnostic;

void setup(){
  XS_Init();
  Serial.begin(9600); //Initialize the Serial communication through USB

  SetMonitoring(6); //CSNS pin feeds back the Power supply voltage
}

void loop(){

  SetOutputState(2,1); //Set output 2 fully ON

  /*
  * Put the voltage value sent by the CSNS pin in voltage variable
  */
  voltage = GetVPWR(); 
  Serial.println(“Vpwr :” + voltage);//Print the voltage variable into the
//Serial Monitor
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  SetPWMDuty(3, 127); //Set output 3 to 50% pwm duty cycle 

  /*
  * Read Quick Status register of the product
  * For more information about the product refer to MC17XSG500 datasheet 
  * in SPI Output Register and Bit Descriptions
  */
  diagnostic = ReadRegister(1);                            
}

7 Schematics, board layout and bill of materials

The board schematics, board layout and bill of materials are available at http://
www.nxp.com/FRDM-32XSG-EVB on the Overview tab under Get Started.

8 References

The following URLs reference related NXP products and application solutions:

NXP.com support pages Description URL

FRDM-32XSG-EVB Tool summary page www.nxp.com/FRDM-32XSG-EVB

MC32XSG Product summary
page

www.nxp.com/MC32XSG

http://www.nxp.com/FRDM-32XSG-EVB
http://www.nxp.com/FRDM-32XSG-EVB
www.nxp.com/FRDM-32XSG-EVB
www.nxp.com/MC32XSG
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9 Revision history
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1.0 20170227 • Initial version of the document

2.0 20180216 • Updated the software drivers download link for Arduino in Section 6.3 "Setting up the software"
• Added description to download the library files from Code Aurora in Section 6.3 "Setting up the

software"
• Updated Section 4 "Getting started"
• Deleted Jump start
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10 Legal information

10.1  Definitions
Draft — The document is a draft version only. The content is still under
internal review and subject to formal approval, which may result in
modifications or additions. NXP Semiconductors does not give any
representations or warranties as to the accuracy or completeness of
information included herein and shall have no liability for the consequences
of use of such information.

10.2  Disclaimers
Limited warranty and liability — Information in this document is believed
to be accurate and reliable. However, NXP Semiconductors does not
give any representations or warranties, expressed or implied, as to the
accuracy or completeness of such information and shall have no liability
for the consequences of use of such information. NXP Semiconductors
takes no responsibility for the content in this document if provided by an
information source outside of NXP Semiconductors. In no event shall NXP
Semiconductors be liable for any indirect, incidental, punitive, special or
consequential damages (including - without limitation - lost profits, lost
savings, business interruption, costs related to the removal or replacement
of any products or rework charges) whether or not such damages are based
on tort (including negligence), warranty, breach of contract or any other
legal theory. Notwithstanding any damages that customer might incur for
any reason whatsoever, NXP Semiconductors’ aggregate and cumulative
liability towards customer for the products described herein shall be limited
in accordance with the Terms and conditions of commercial sale of NXP
Semiconductors.

Right to make changes — NXP Semiconductors reserves the right to
make changes to information published in this document, including without
limitation specifications and product descriptions, at any time and without
notice. This document supersedes and replaces all information supplied prior
to the publication hereof.

Suitability for use — NXP Semiconductors products are not designed,
authorized or warranted to be suitable for use in life support, life-critical or
safety-critical systems or equipment, nor in applications where failure or
malfunction of an NXP Semiconductors product can reasonably be expected
to result in personal injury, death or severe property or environmental
damage. NXP Semiconductors and its suppliers accept no liability for
inclusion and/or use of NXP Semiconductors products in such equipment or
applications and therefore such inclusion and/or use is at the customer’s own
risk.

Applications — Applications that are described herein for any of these
products are for illustrative purposes only. NXP Semiconductors makes
no representation or warranty that such applications will be suitable
for the specified use without further testing or modification. Customers
are responsible for the design and operation of their applications and
products using NXP Semiconductors products, and NXP Semiconductors
accepts no liability for any assistance with applications or customer product
design. It is customer’s sole responsibility to determine whether the NXP
Semiconductors product is suitable and fit for the customer’s applications
and products planned, as well as for the planned application and use of
customer’s third party customer(s). Customers should provide appropriate
design and operating safeguards to minimize the risks associated with
their applications and products. NXP Semiconductors does not accept any
liability related to any default, damage, costs or problem which is based

on any weakness or default in the customer’s applications or products, or
the application or use by customer’s third party customer(s). Customer is
responsible for doing all necessary testing for the customer’s applications
and products using NXP Semiconductors products in order to avoid a
default of the applications and the products or of the application or use by
customer’s third party customer(s). NXP does not accept any liability in this
respect.

Export control — This document as well as the item(s) described herein
may be subject to export control regulations. Export might require a prior
authorization from competent authorities.

Non-automotive qualified products — Unless this data sheet expressly
states that this specific NXP Semiconductors product is automotive qualified,
the product is not suitable for automotive use. It is neither qualified nor
tested in accordance with automotive testing or application requirements.
NXP Semiconductors accepts no liability for inclusion and/or use of non-
automotive qualified products in automotive equipment or applications. In
the event that customer uses the product for design-in and use in automotive
applications to automotive specifications and standards, customer (a) shall
use the product without NXP Semiconductors’ warranty of the product for
such automotive applications, use and specifications, and (b) whenever
customer uses the product for automotive applications beyond NXP
Semiconductors’ specifications such use shall be solely at customer’s own
risk, and (c) customer fully indemnifies NXP Semiconductors for any liability,
damages or failed product claims resulting from customer design and use
of the product for automotive applications beyond NXP Semiconductors’
standard warranty and NXP Semiconductors’ product specifications.

Evaluation products — This product is provided on an “as is” and “with all
faults” basis for evaluation purposes only. NXP Semiconductors, its affiliates
and their suppliers expressly disclaim all warranties, whether express,
implied or statutory, including but not limited to the implied warranties of
non-infringement, merchantability and fitness for a particular purpose. The
entire risk as to the quality, or arising out of the use or performance, of this
product remains with customer. In no event shall NXP Semiconductors, its
affiliates or their suppliers be liable to customer for any special, indirect,
consequential, punitive or incidental damages (including without limitation
damages for loss of business, business interruption, loss of use, loss of
data or information, and the like) arising out the use of or inability to use
the product, whether or not based on tort (including negligence), strict
liability, breach of contract, breach of warranty or any other theory, even if
advised of the possibility of such damages. Notwithstanding any damages
that customer might incur for any reason whatsoever (including without
limitation, all damages referenced above and all direct or general damages),
the entire liability of NXP Semiconductors, its affiliates and their suppliers
and customer’s exclusive remedy for all of the foregoing shall be limited to
actual damages incurred by customer based on reasonable reliance up to
the greater of the amount actually paid by customer for the product or five
dollars (US$5.00). The foregoing limitations, exclusions and disclaimers
shall apply to the maximum extent permitted by applicable law, even if any
remedy fails of its essential purpose.

Translations — A non-English (translated) version of a document is for
reference only. The English version shall prevail in case of any discrepancy
between the translated and English versions.

10.3  Trademarks
Notice: All referenced brands, product names, service names and
trademarks are the property of their respective owners.
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